
CCA-101: Fundamentals of It & programing 

Asignment-1 

Q.1:  What are the four fundamental parts of computer? explain it with the help of diagram. 

Ans: The four fundamental parts of computer are: 

1. Input Device: Computer systems used many devices for input purposes. Input device include the 

mouse, input pen, touch screen, and microphone. Regardless of type of device used, all are 

components for interpretation and communication between people and computer systems. 

2. Central Processing Unit: It is the brain of the computer without this unit computer unable to 

process. 

3. Output Device: Output device is used to show the result of the instructions. Example- Monitor, 

Printer, Headphones etc. 

4. Memory Unit: A memory unit is the collection of storage units or device together. The memory 

unit stores the binary information in the form of bits. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Q.2: Discuss about the classification of computers based on size and capacity. 

Ans: Based on the size and capacity, computers are classified as 

1) Super computers: They have thousands of processors. Because of their extraordinary speed, 

accuracy and processing power, super computers are well suited for solving highly complex problems 

and huge amount of calculations. 

e.g. JAGUAR, ROADRUNNER etc. 

Input 
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2) Mainframe computers: they are very large often filling an entire room and can process thousands of 

millions of instructions per second. They are capable of supporting hundreds to thousands of users 

simultaneously. Function performed by mainframes include flight scheduling reservations and ticketing 

for an airline etc. 

3) Minicomputers: they are much smaller than mainframes. They are typically larger, more powerful and 

more expensive than desktop computers. Users connect to server through a network by using desktop 

computers. 

e.g. apple I pod, CDC 160A. 

4) Microcomputers: They are most frequently used type of computers. It is also known as personal 

computers. 

e.g. desktop computer, laptop. 

Q.3: What is the meaning of computer generation? How many Computer Generations are defined? 

What technologies were/are used? 

Ans: Generation in computer terminology is change in technology of a computer which were being used. 

There are four computer generation such as 1st generation,2nd generation, 3rd generation and 4th 

generation. 

In the first computer system, Vacuum tubes were used. 

Transistors were used in the second generation. 

Integrated circuit technology were used in the third generation. 

In the fourth generations microprocessors are used. 

Q.4: Differentiate between Volatile and Non-Volatile Memories. 

Ans: - 

 

 

 

 

 

 

 

Q.5: Distinguish among system software, application software and open source software on the basis of 

features. 

Volatile memory 

1. It is a computer storage that only 

maintains its data while the device 

is powered. 

2. E.g. RAM 

3. Primary memory has limited 

storage capacity and is volatile. 

Non-volatile memory 

1.  It is a type of computers memory 

that has the capability to hold saved 

data even if the power id turned off. 

2. E.g. ROM, hard disk, floppy disk, etc. 

3. Secondary memory provides 

permanent storage of data and in bilk 

quantity 



Ans: - System software. It is a type of software that is designed to run a computer’s hardware and 

application programs. Software like operating systems, compiler, editor and driver etc. Come under this 

category. A computer cannot function without the presence of system software. 

Application software: It is a type of software created for specific purpose used by end users. It can be 

called an application or simply an app. 

    Examples: word processors, accounting app etc. 

Open source software: It is a type of computer software in which source code is released under a license 

in which the copyright holder grants users rights to study, change and distribute the software to anyone 

and for any purpose. 

   E.g. The Linux operating system. 

Q.6: a) Create a file in MS-word to insert a paragraph about yourself and save it with file name 

”yourself”. Describe all steps involved in it. 

Q.6: b) write steps regarding followings 

➢ To change the font style 

➢ To change the font size 

➢ To change the font color 

➢ To highlight (in yellow) the line that reads “need to get IMS’s address”. 

(a, b) Ans: - “Yourself” 

     My name is Hmangte Blisson Kom. I am 19 years old. I Love to sing and listen to music. I am a student 

of arts at IMPHAL COLLEGE, MANIPUR. Currently I am learning computer CCA course at RGI TRAINING 

INSTITUTION. 

The steps involved are: 

1. We click the Microsoft6 office button. 

2. We select new. The new document dialog box appears. 

3. We click blank document under the blank and recent section. It will be highlighted by default. 

4. We click create. A new blank document appears in the word window. 

5. To save the document, we click again the Microsoft office button. 

6. We select save as         word document. The save dialog box appears. 

7. We select the location where we want to save the document using the drop-down menu. 

8. We click the save button.   

b) Ans: step to change the font style: 

1. we select the text we want to modify. 

2. Left click the drop-down arrow next to the font style box on the home tab. The font style 

drop-down menu appears. 

3. we move the cursor over the various font styles. A live preview of the font appears in the 

document. 

4. Left click the font style we want to use. The font style will change in the document  

 Step to change the font size 



1. We select the text we want to modify 

2. Left click the drop-down arrow next to the font size bow on the home tab. The font size 

drop-down menu appears. 

3. We move the cursor over the various font sizes. A live preview of the font size will appear on 

the document. 

4. Left click the font size we want to use. The font size will change in the document. 

Steps to change the font color 

1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font color bow on the home tab. The font color 

menu appears. 

3. We move the cursor on various font colors. A live preview of the color will appear in the 

document. 

4. Left click the font color we want to use. The font color will change in the document. 

Steps to highlight the line 

1. We select the line that reads “needs to get IMS’s address” 

2. We click the highlight command and  

 

 

 

Q.7: Create a file in MS-word for the following document and save it with file name ‘ms-word’. Describe 

all steps involved in it.  

7.Ans: - MS Word 

MS word is a widely used commercial word processor developed by Microsoft. 

MS word is application software, which is capable of 

• Creating 

• Editing 

• Saving and 

• Printing any type of document 

 

 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section it will be highlighted by default. 

4. We click create. A new blank document appears in the word window. 

5. We create the given documents from the question 

6. We select the text “MS word” and change the font size by clicking on the font sizer box on the 

home tab. 



7. We select the text “MS word” to change the font the font color into red by clicking on the font 

color menu on the home tab. 

8. We select the text word processor and underline it by clicking the underline command in the 

font group the home tab. 

9. We select the text “MS word” to change the font style into italic by clicking italic command. 

10. We select the text we want to format as a list and click on the bullets command on the home 

tab. 

11. We change the font color of the text “creating” and “saving” into blue and red resp. by clicking 

on the font color command, again we select the text “and” and click on strikethrough command. 

12. We select the text “printing any type of document” and change the font style into bold by 

clicking on the font style command. 

13. We save the file name as “MS-word” by clicking the Microsoft office button and select save as 

14. We select the location where we want to save the document using drop-down menu 

15. We click the save button. 

Q.8: Create a file in MS-word for the following document and save it with file name ’equations’. 

Describe all steps involved in it. 

Equations 

X2 + Y5 = 30 

Z2 + Q4 = 50 

A2 +B8 = X2 + Y8 

Ans: - Equation 

X2 + Y5 =30 

Z3 + Q4 =50 

A2 + B8 = X2 + Y8 

The steps are: 

1. We create the given documents in MS-word 

2. We select the text where we want to format and click on the subscript and superscript 

Command on the home tab 

3. We save the file name as “equations” by clicking the Microsoft office button and select save 

as  

4. We select the location where we want to save the document using the drop-down menu 

5. We click the save button 

Q.9: Create a file in MS-word that convert existing highlight text to table as shown below and save it as 

file name ‘text_to _table’. Describe all the step involved in it. 

   Select the text you want to convert. 

   Select the Insert tab. 

Click on Table command. A dialog box appears. 



Click on Convert Text to Table, a new  dialog box appears here set number of columns. 

Click on OK. Finally Selected text convert in a Table. 

 

Ans:  To convert existing text to a table: 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab 

3. We click the table command 

4. We select convert text to table from the menu.  A dialog box appears 

5. We click ok. Then the text appears in a table. 

Q.10:  Create a file in MS-word to insert a Table in the document. Describe all the steps involved in it. 

Ans: 

         

         

         

         

         

         

         

 

The steps are: 

1. We place our insertion point in the document where we want our table to appear 

2. We select the insert tab 

3. We click the table command 

4. We drag our mouse over the diagram squares to select the numbers of columns and rows in the 

table 

5. Left click our mouse and the table appears in the document. 

6. We enter the text into the table 

Q.11: Create a following worksheet in MS-word an save it with the name’book1’. 

Ans: 

Select the text you want to convert. Select the Insert tab. 

Click on Table command. A dialog box appears. Click on Convert Text to Table, a new dialog box appears 

Here set number of columns. Click on OK. Finally Selected text convert in to table. 



 

 

 

 

 

 

 

 

 

Q.12:  Calculate the following things of a range (C2:C11) end of data in the worksheet created in no. 10 

➢ The sum of the mark using auto Sum in a range of cells (C2:C11) 

➢ average of the marks in a range of cells (C2:C11) 

➢ highest marks in a range of cells (C2:C11) 

➢ minimum marks in a range of cells (C2:C11) 

Ans: 

No Name Marks Sum Average Maximum Minimum

1 n1 60 654 65.4 90 40

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  

Q.13 (a) Describe various Step involved in the following 

➢ To modify column width of a worksheet 

➢ To modify the row height of a worksheet 

➢ To modify rows and columns of a worksheet 

Ans: -  

➢ To modify column width of a worksheet: 

i. Select a column or a range of columns. 

ii. Select a Home tab and in the cells group, select format. 

iii. Click on column width and type the width for column. 

No Name Marks 

1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 

10 n10 55 



iv. Select OK. 

➢ To modify the row height of a work sheet: 

i. Select a row or a range of rows. 

ii. Select a Home tab and in the cells group, select format. 

iii. Click on Row Height and type the height for row. 

iv. Select OK. 

➢ To delete rows and columns of a worksheet: 

i. Select the cell you want to delete within the column or row. 

ii. Select Home tab. And in cells group click on b Delete Sheet Column or Row. 

                         OR 

iii. Select the desire row or column. 

 

Q.13 (b) Describe following terms in the worksheet 

➢ Absolute reference and relative reference in formula 

➢ Cell address 

Ans: 

➢ Absolute Reference: 

An absolute reference in excel means there is fixed point of reference applied to a cell or a 

formula. This is so the return value will always stay the same no matter where the cell or 

formula moves to-within same sheet or across different sheet. 

This refers to a fixed point of reference is a constant, and involves the use of dollar sign $ in the 

formula (i.e., everyone is to receive the same bonus payout, so the amount $1500 is constant I 

this situation).  

 

➢  Relative Reference: It is the default cell reference in excel. It is simply the combination of 

column name and row number without any dollar ($) sign. When you copy the formula from one 

cell to another the relative cell address changes depending on the relative position of column 

and row. C1, d2, e4, perform a similar operation on multiple cells and the formula must change 

according to the relative address of the column and row. 

 

This refers to a relative point of reference, is constantly changing and dollar sing ($) is absent in 

the formula (i.e., when each unit price and quantity are difference variables, there’s no constant 

in the calculation). 

➢ Cell address: 

A cell address is a combination of column letter and a row number that identifies a cell on a 

worksheet. 

For example, A1 refers to cell at the intersection of column A and row 1: B2 refers to the second 

cell in column B, and so on. 

   When used formula, cell references help Excel find the values the formula should calculate. For 

instance, 

➢ To pull the value of A1 to another cell, you use this simple formula: 

=A1 



➢ To add up the values in cells A1and A2, you use this one: 

=A1+A2 

Q.14 (a) What tools are available to customize our PowerPoint presentation? 

Ans:  Tools available to customize our PowerPoint presentation are: 

a) Perspector 

b) Pivot viewer 

c) Autodesk 3DS Max 

d) Visual Bee PowerPoint Add-in  

e) SmartArt 

f) Animations and Transition  

g) Wordle 

h) CA coo 

i) Oomfo 

j) Clip champ 

Q.14:(b) Write the steps for the following action for creation of PowerPoint presentation 

➢ Open a Blank presentation 

➢ Save the presentation as Lab.1.pptx 

➢ Add a Title to the first slide: the name of your college 

➢ Type your first name in the Subtitle section 

➢ Add a new slide which has a Title and Content 

Ans: -  

➢ To open blank presentation: 

i.  Open PowerPoint presentation using ‘Run’ command (window key+ R). 

ii. Select the ‘blank presentation’. It is opened 

➢ Save the presentation as Lab1.pptx: 

i. Select the ‘File’ on Tab bar. 

ii. Click on ‘Save As’ option. 

iii. Click on document/desktop as your choice. 

iv. Type the name ‘Lab1.pptx’. 

v. Click the ‘Save’ button. 

 

 

➢ Add a Title to the first slide: the name of your college. 

i. Left click on the ‘Click to Add Title’ section on the first slide. 

ii. Type the name of your college. 

➢ Type your name and last name in the subtitle section: 

i. Left click on the ‘Click to Add Subtitle’ section. 

ii. Type your name and last name 

➢ Add a New slide which has a Title and content. 



i. Select the Home tab. 

ii. Click on the dropdown button of the ‘New slide’ on toolbar. 

iii. Select the slide having ‘Title and Content’. It is added. 

Q.15: Write steps for creation of set of PowerPoint slides that demonstrates your skill to use the tools of 

PowerPoint. It should include the following things 

➢ Title slide &Bullet list 

➢ Insert Excel sheet 

➢ Clip art and Text 

➢ Slide show effects 

Ans: -  

➢ Title slide and bullet list: 

i. Open PowerPoint Presentation. 

ii. Select the Home tab. 

iii. Click at the dropdown button on ‘New Slide’ at toolbar. 

iv. Select the slide having Title slide and Bullet list. 

➢ Insert Excel Sheet: 

i. Open the slide where you want to insert the Excel Sheet. 

ii. Select the ‘Insert tab’. And click on ‘object’ on the tool bar. 

iii. Select the ‘Micro Excel Worksheet’ object type. 

iv. Click the ‘OK’ button. 

➢ ClipArt and Text: 

i. Select the insert Tab. 

ii. Select the ‘Pictures’ or ‘Online Pictures’ on the tool bar. 

iii. Choose the appropriate art for the topic. Click on the ‘Insert’ button. 

➢ Slide show effects: 

i. Select ‘Design Tab’ for themes, Variants and Slide size. 

ii. Select ‘transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, etc. for slide 

effects. 

PART-2 

Q.16: What is the difference Machine language and High Level Language? 

Ans: - 

 

Machine Language High level Language 



 

Q.17: Discuss about different data types of C programming Language. 

Ans: - The different data types of c programming language are: 

Char: The most basic data type in c. It stores a single character and requires a single byte of memory in 

almost all compilers. 

Int: As the name suggest, an int variable is used to store integer. 

Float: It is used to store decimal numbers. 

Double:  It is used to store decimal numbers (number with floating point value but its range of values is 

high in comparison to float). 

Q.18: Find the output of the following expressions 

a) X=20/5*2+30-5.  b) Y=30-(40/10+6) + 10   c) Z=40*2/10-2+10 

Ans: -  

A) X= 33 

B) Y=30 

C) C= 16 

Q.19: Describe the syntax of the following statement 

a) If -else statement b) For loop c) While loop d) Do-while loop 

Ans: - a) If- else statement: 

 If statements can be followed by an optional else block of statements, which executes when the boot 

can expression is false. 

Syntax 

If (expression) 

{ 

True block of statements; 

1. A computer programming language 

consisting of binary instructions 

which a computer can respond to 

directly. 

2. It requires no translator to translate 

the code. It is directly understood by 

the computer. 

3. This language makes fast and efficient 

use of the computer 

1. It is a programming language that 

enable s development of a program in 

a much more users friendly 

programming context 

2. It takes additional translate time to 

translate the source code to machine 

code. 

3. They are programmer friendly 



} 

Else 

{ 

Else block of statements; 

} 

b) For loop is similar to while loop. Basic syntax of for loop is as follows: 

For (expression 1; expression 2; expression3) 

{ 

Block of statement 

} 

In the above syntax 

Expression1- initializes variables. 

Expression2-conditional expression as long as this condition is true, loop will keep executing. 

Expression- it is t5he modifier which will increase or decrease the value of the variable. 

c) While loop. 

Basic syntax of while loop is as follows 

While (condition) 

Single statement. 

Or while (Condition)  

{ 

Block of statement 

} 

d) Do-while loop. 

Do-while loop is just like a while loop except that the text condition is checked at the end of the loop 

rather than the start. This has the effect that the body of the loop are always executed at least once 

Basic syntax of do-while is follows 

Do 

{ 

Single statement 



Or  

Block of statements 

} while (condition): 

Q.20: Find the output of the following program segments 

 

 

Ans: - 

A)1 

B) 2 

C) b= 100 

 

 

 

 

 

 

 

 

 

 

a) b) c) 

#include <stdio.h> 

Int main() 

{  

Int i; 

For (i=1; i<2; i++) 

{ 

printf(“IMS Ghaziabad\n”); 

} 

} 

#include <stdio.h> 

Int main() 

{  

Int i=1 

while ( i<=2 ) 

{ 

printf(“IMS Ghaziabad\n”); 

I=i+1; 

} 

} 

 

#include <stdio.h> 

void main() 

{  

Int a=10, b=100; 

If(a>b) 

printf(“larger number is %d\n”, a); 

else 

printf(“larger number is %d\n”, b); 

} 

 


